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เนื้อหา

• ระบบจาวา
• โครงของโปรแกรม
• ประเภทขอมูล
• ขอมลูพื้นฐานชนิดตางๆ
• ตัวแปร
• ตัวดําเนินการตางๆ
• การเปลี่ยนประเภทขอมูล
• โครงสรางการทํางานแบบตางๆ
• อาเรย
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Java Technology

• Java Programming Language
• Java Platform

– Java Virtual Machine
– Java API

Solaris, Linux, Windows, Mac OS X, HP-UX, IBM-AIX, 
OS/390, PDA, Java-enabled cell phones, GameBoy Advance, ...
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Language Features

• 1995 (1.0) : first public release
– A simple, object-oriented, network-savvy, 

interpreted, robust, secure, architecture neutral, 
portable, high-performance, multithreaded, 
dynamic language.

• 1997 (1.1) : nested classes
• 2001 (1.4) : assert
• 2004 (1.5 หรือ Java 5) :

– generics, enum, enhanced for, 
autoboxing/unboxing, varargs, static import, 
metadata.
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Java Platforms

• Standard Edition (J2SE)
– client-side general-purpose applications

• Enterprise Edition (J2EE)
– multi-tier server-centric applications 

• Micro Edition (J2ME)
– consumer and embedded devices



© S.Prasitjutrakul 2004 16/01/48 6



© S.Prasitjutrakul 2004 16/01/48 7

Java API

version #packages #classes
1.0 8 212
1.1 23 504
1.2 59 1520
1.3 76 ~1800
1.4 135 ~2800
1.5 164 ~3300

Ja
va

 2
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/* First Java Program
*/
package com.somchai;

public class Hello {
public static void main(String[] args) {

System.out.print("Hello ");
System.out.println("World"); 

}
} // end of class Hello

/* First Java Program
*/
package com.somchai;

public class Hello {
public static void main(String[] args) {

System.out.print("Hello ");
System.out.println("World"); 

}
} // end of class Hello

การแปลและสั่งทํางาน

C:\>javac Hello.java

C:\>java Hello

Hello World

C:\>

Hello.java

javac
(compiler)

java 
(launcher)

Hello.class
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/* First Java Program
*/
package com.somchai;

public class Hello {
public static void main(String[] args) {

System.out.print("Hello ");
System.out.println("World"); 

}
} // end of class Hello

/* First Java Program
*/
package com.somchai;

public class Hello {
public static void main(String[] args) {

System.out.print("Hello ");
System.out.println("World"); 

}
} // end of class Hello

Comments

commentcomment
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www.eclipse.org

• ติดตั้ง j2sdk (http://java.sun.com/j2se) 
• ติดตั้ง eclipse (http://www.eclipse.org)  

– download   “eclipse-SDK-????.zip”
– unzip และ execute  “eclipse.exe”
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Eclipse Workbench
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File -> New -> Project...
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Java Perspective
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File -> New -> Class

1
2

4

5

ตั้งชื่อคลาส Hello

อยูในแพ็กเกจ com.somchai

คลาสใหมนี้มีชื่อเต็ม
com.somchai.HelloWorld

3
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Editor
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Run -> Run As -> Java Application
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ประเภทขอมูล

• ประเภทพื้นฐาน
– มี 8 ประเภท

• จํานวนเต็ม : byte, short, int, long
• จํานวนจริง : float, double
• อักขระ : char
• ตรรกะ : boolean

– ออกแบบเพิ่มเติมไมได

• ประเภท class
– มีแบบมาตรฐานหลายพนัแบบ

• เชน String, Text, Rectangle, ...

– ออกแบบเองเพิ่มเติมได
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Primitive Data Types

• จํานวนเต็มมีสี่ขนาด
– byte 8 บิต (-27  ถงึ 27 - 1)
– short 16 บติ (-215 ถงึ 215 - 1)
– int 32 บติ (-231 ถงึ 231 - 1)
– long 64 บติ (-263 ถงึ 263 - 1)

• จํานวนจริงมสีองขนาด
– float เก็บประมาณ 6-9 ตําแหนงหลังจุดทศนิยมในชวง

( -3.4x1038 ถึง -1.4x10-45 ศูนย และ 1.4x10-45 ถงึ 3.4x1038)
– double เก็บประมาณ 15-17 ตําแหนงหลังจุดทศนิยมในชวง

( -1.8x10308 ถึง -4.9x10-324 ศูนย และ 4.9x10-324 ถงึ 1.8x10308)

โดยทั่วไปใช  int  กบั doubleโดยทั่วไปใช  int  กบั double
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Primitive Data Types

• boolean
– มีไดแคสองคาคือ true และ false เทานัน้
– 1 ไมไดแทน true 0 ไมไดแทน false

• char ใช Unicode (16 บิตตอ 1 ตัว)
– 'A',  'B', 'ก',  'β',  '\n'

• String
– ไมใช primitive data type
– "hello",  "",  "hello\nworld"
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การเขียนคาคงตัวทีข่องจํานวน

1010

10L10L

10.0310.03

10.03F10.03F

010010

int

long

double

float

base 8
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การประกาศตัวแปร

int counter = 0;
double radius  = 5.225;
boolean success = false;
char korKai = 'ก';
String name    = "somchai";

int counter = 0;
double radius  = 5.225;
boolean success = false;
char korKai = 'ก';
String name    = "somchai";

ประเภทขอมูล ชื่อตัวแปร คาเริ่มตนของขอมูล
ที่เก็บในตัวแปร

int i = 100, j = 200;
double x0, y0, z0;
double x1, y1 = 4.5, z1 = 7.8;

int i = 100, j = 200;
double x0, y0, z0;
double x1, y1 = 4.5, z1 = 7.8;

ประกาศบรรทัดละหลายตัว หรือจะไมใสคาเริ่มตนก็ได
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ตัวอยางการประกาศตัวแปรที่ผดิ

int counter = 0.75;
double radius  = "15.25";
boolean success = 1;

int counter = 0.75;
double radius  = "15.25";
boolean success = 1;

integer counter;
doublE radius  = 15.25;
string title = "WWW";

integer counter;
doublE radius  = 15.25;
string title = "WWW";

int boolean;
double public = 12.7;
String 12X = "WWW";

int boolean;
double public = 12.7;
String 12X = "WWW";

int counterint counter
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กฎการตั้งชื่อ

• ชื่อประกอบดวยตัวอักษร ตัวเลข ตัว $ หรอื _ ก็ได
• ชื่อหามขึ้นตนดวยตัวเลข
• ชื่อยาวๆ ไดไมเปนไร
• ตัวอักษรตัวใหญไมเหมือนตัวเลก็
• ตองไมซ้ํากับคําสงวนของภาษาจาวา

ตัวอยางถูก

int17  butterCup Public  int2String  day_of_weekint17  butterCup Public  int2String  day_of_week

ตัวอยางผิด

7zean  I.love.you  public ohOH!  ed-edd-n-eddy7zean  I.love.you  public ohOH!  ed-edd-n-eddy
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คําสงวนในภาษาจาวา

abstract    assert boolean break       byte
case        catch      char          class       const
continue    default    do            double      else
extends     false      final         finally     float
for         goto if            implements  import
instanceof int interface     long        native
new         null       package       private     protected
public      return     short         static      strictfp
super       switch     synchronized  this        throw
throws      transient  true          try         void
volatile    while enum

หามนาํคาํสงวนมาตั้งเปนชือ่ตัวแปร
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Operators

• +   − *  /   ++   − −
• %  เศษของการหาร
• == เทากัน ?
• != ไมเทากัน ?
• <  <=   >  >=
• ! NOT
• && AND
• | | OR
• + เมือ่ใชกับ String จะหมายถึง concatenation
String s = "answer = " + 1 + 2 + 3; //answer123
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การเปลี่ยนประเภทขอมูล

• Widening
– เปลี่ยนจากประเภทขอมูลทีม่ีชวงแคบกวา
ไปยังประเภทขอมูลทีม่ีชวงกวางกวา

• Narrowing
– กลับกนั, ขอมูลอาจหาย
– ถาตองการ narrow ตองทํา casting

int i = 123;
long w = i;
double d = 2;
double x = i / d;

int i = 123;
long w = i;
double d = 2;
double x = i / d;

float f = (float) 4.2;
int i = (int) (f / 2);

float f = (float) 4.2;
int i = (int) (f / 2);

byte < short < int < long < float < doublebyte < short < int < long < float < double
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คําถาม

double x = (1/2 + 1/2);double x = (1/2 + 1/2); x มีคาเทาใด ?

float y = 1.0/2.0;float y = 1.0/2.0; y มีคาเทาใด ?

double z = 4d + 5;double z = 4d + 5; z มีคาเทาใด ?

double u = 0.0 + 1/2;double u = 0.0 + 1/2; u มีคาเทาใด ?

double v = (0.0 + 1)/2;double v = (0.0 + 1)/2; v มีคาเทาใด ?

double f = 212.0;
double c = (5/9) * (f - 32);

double f = 212.0;
double c = (5/9) * (f - 32); c มีคาเทาใด ?
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Statements and Blocks

int x = 0, y = 0;

x = x + 1; x = 2 * x;

y =

x;

int x = 0, y = 0;

x = x + 1; x = 2 * x;

y =

x;

int y = 0;

{

int x = 0;

x = x + 1;

x = 2 * x;

y = x; // can use y

}

x++;  // compile-error

int y = 0;

{

int x = 0;

x = x + 1;

x = 2 * x;

y = x; // can use y

}

x++;  // compile-error
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Selection : if, if-else

if (Boolean Expression) 
a statement ;

if (Boolean Expression) 
a statement ;

if (Boolean Expression){
statement(s) ;

}

if (Boolean Expression){
statement(s) ;

}

if (Boolean Expression) 
a statement ;

else
a statement ;

if (Boolean Expression) 
a statement ;

else
a statement ;

if (Boolean Expression){ 
statement(s) ;

} else {
statement(s) ;

}

if (Boolean Expression){ 
statement(s) ;

} else {
statement(s) ;

}

if ((y % 4 == 0 && y % 100 != 0) || (y % 400 == 0)) {
...

}

if ((y % 4 == 0 && y % 100 != 0) || (y % 400 == 0)) {
...

}
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Selection : switch-case

int option = 5;
...
switch (option) {
case 1 :
case 21 :

System.out.println("1 or 21");
break;

case 3 :
System.out.println("3");
break;

default :
System.out.println("not 1, 21, and 3");
break;

}

int option = 5;
...
switch (option) {
case 1 :
case 21 :

System.out.println("1 or 21");
break;

case 3 :
System.out.println("3");
break;

default :
System.out.println("not 1, 21, and 3");
break;

}
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Loops : do-while, while

do {
do this

} while ( Boolean expr );

do {
do this

} while ( Boolean expr );

do this

Boolean expr.

false

true

while ( Boolean expr ) { 
do this

}

while ( Boolean expr ) { 
do this

}

do this

Boolean expr.
false

true
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Loops : for

for ( initialization ; condition ; update ) { 
do this

}

for ( initialization ; condition ; update ) { 
do this

}

update

condition
false

true

initialization

do this

for( i=0; i < 30; i++ ) {
System.out.println(i) )

}

for( i=0; i < 30; i++ ) {
System.out.println(i) )

}

i = 0;
while( i < 30 ) {
System.out.println(i);
i++

}

i = 0;
while( i < 30 ) {
System.out.println(i);
i++

}
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Variable Declaration in for

{
int i;
for( i = 0; i < 30; i++ ) {

...
}

}

{
int i;
for( i = 0; i < 30; i++ ) {

...
}

}

for( int i = 0; i < 30; i++ ) {
...

}

for( int i = 0; i < 30; i++ ) {
...

}

declaration statementdeclaration statement
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break

while (! success()) {
...
if (ohNo()) break;
...

}

while (! success()) {
...
if (ohNo()) break;
...

}

for (int i = 0; i < n; i++) {
for (int j = 0; j < n; j++) {

if (ohNo()) break;
...

}
if (ohNo()) break;
...

}

for (int i = 0; i < n; i++) {
for (int j = 0; j < n; j++) {

if (ohNo()) break;
...

}
if (ohNo()) break;
...

}
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continue

while (! success()) {
...
if (ohNo()) continue;
...

}

while (! success()) {
...
if (ohNo()) continue;
...

}

do {
...
if (ohNo()) continue;
...

} while (! success());

do {
...
if (ohNo()) continue;
...

} while (! success());

1
2

1

2

for (int i = 0; i < n; i++) {
...
if (ohNo()) continue;
...

}

for (int i = 0; i < n; i++) {
...
if (ohNo()) continue;
...

}

1

2
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การประกาศและการสรางอาเรย

• กอนใชอาเรย ตอง
– ประกาศ ตัวแปรอาเรย
– สราง ตัวอาเรย

int [] data;int [] data;

ประกาศตัวแปรชื่อวา data มีไวอางอิงอาเรยของ int

data = new int[5];data = new int[5];

สรางอาเรยของ int จํานวน 5 ชอง แลวให data เปนตัวแปรสําหรับ
อางอิงอาเรยที่ไดสรางขึ้น

int [] data = new int[5];int [] data = new int[5];

ประกาศตัวแปรและสรางอาเรยพรอมกันเลยก็ได

0 0 0 0 0

data 0   1   2   3   4

new
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ขอสังเกต : การประกาศ+การสราง

• การประกาศตัวแปรอาเรย ไมไดเปนการสรางตัวอาเรย
• ขนาดของอาเรยถกูกําหนดตอนสรางตัวอาเรย ไมใช
ตอนประกาศตัวแปร

• ขนาดของอาเรยเปนคาของนิพจนก็ได
( data = new int[ 3*n + 1]; )

• อาเรยที่สรางขึ้น ไมสามารถเพิ่มหรือลดขนาดได
• ระบบจะตั้งคาเริ่มตนของขอมูลในอาเรยโดยอัตโนมัติ 

(ใหคาศูนยกับอาเรยของจํานวน และ ใหคา false กับ
อาเรยของ boolean)
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การใชขอมูลในอาเรย

• ใช d[k] แทนตัวที่ k ในอาเรย d
• index ของอาเรยเริ่มที่ 0 เสมอ
• ถาอาเรยมีขนาด n ตัว index ตองเปนจํานวนเต็ม
มีคาไดตั้งแต 0 ถึง n-1

public class Array1 {
public static void main(String[] args) {
int[] a = new int[100];
for (int i = 0; i < 100; i++) a[i] = i;
int sum = 0;
for (int i = 0; i < 100; i++)
sum += a[i];

System.out.println(sum);
}

}

public class Array1 {
public static void main(String[] args) {
int[] a = new int[100];
for (int i = 0; i < 100; i++) a[i] = i;
int sum = 0;
for (int i = 0; i < 100; i++)
sum += a[i];

System.out.println(sum);
}

}
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ประกาศ+สราง+ตั้งคาเริ่มตน

int[] data = new int[3];
data[0] = 23;
data[1] = 3;
data[2] = 47;

int[] data = new int[3];
data[0] = 23;
data[1] = 3;
data[2] = 47;

int[] data = {23, 3, 47};int[] data = {23, 3, 47};

• ใช initializer list ระบคุาเริม่ตน
• ไมตองกาํหนดจํานวนชองที่จะสราง
• จํานวนชองทีส่รางเทากับจํานวนขอมูลใน list

int[] data;
data = {23, 3, 47};

int[] data;
data = {23, 3, 47}; เขียนแยกเปนสองบรรทัดแบบนี้ไมได

int[] data = new int[] {23, 3, 47};int[] data = new int[] {23, 3, 47};
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ถาอยากรูขนาดของอาเรย

• เติม .length ตามหลังชือ่อาเรย

public class Array1 {
public static void main(String[] args) {
int[] a = new int[100];
for (int i = 0; i < a.length; i++) a[i] = i;
int sum = 0;
for (int i = 0; i < a.length; i++)
sum += a[i];

System.out.println(sum);
}

}

public class Array1 {
public static void main(String[] args) {
int[] a = new int[100];
for (int i = 0; i < a.length; i++) a[i] = i;
int sum = 0;
for (int i = 0; i < a.length; i++)
sum += a[i];

System.out.println(sum);
}

}
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ขอสังเกต : การอางองิอาเรย

• อาเรยแถวหนึ่ง อาจมีตัวแปรหลายตัวอางองิได

a กับ b มีคาเทากัน หมายความวาอางอิงอาเรยเดียวกัน

ดังนั้น a[i] กับ b[i] อางอิงที่เก็บขอมูลที่เดียวกัน

a กับ b มีคาเทากัน หมายความวาอางอิงอาเรยเดียวกัน

ดังนั้น a[i] กับ b[i] อางอิงที่เก็บขอมูลที่เดียวกัน

int [] a  = new int[5];

0 0 0 0 0

a 0   1   2   3   4

int [] b = a;

b
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อยากเปลี่ยนขนาดอาเรย กท็าํได

int[] a = new int[4] {0,1,2,3};
int[] b = new int[2 * a.length];
for (int i = 0; i < a.length; i++) b[i] = a[i];
a = b;

int[] a = new int[4] {0,1,2,3};
int[] b = new int[2 * a.length];
for (int i = 0; i < a.length; i++) b[i] = a[i];
a = b;

0 1 2 3a

0 0 0 0b 0 0 0 0

0 1 2 3b 0 0 0 0

0 1 2 3

b
0 0 0 0

a
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การอางอิงขอมูลแบบผิดๆ

• ถาอาเรยมีขนาด n ตัว
index ตองเปนจํานวนเต็มมีคาไดตั้งแต 0 ถึง n-1

• index ไมใชจํานวนเต็ม - compile error
• index เปนจํานวนเต็มทีอ่ยูนอกชวง

– เกิด ArrayIndexOutOfBoundsException ขณะทาํงาน

public class Array2 {
public static void main(String [] args) {

int [] data = new int[100];
System.out.println( data[100] );

}
}

public class Array2 {
public static void main(String [] args) {

int [] data = new int[100];
System.out.println( data[100] );

}
} C\>java Array2

java.lang.ArrayIndexOutOfBoundsException
at Array2.main(Array2.java:4)

Exception in thread "main"
C\>

C\>java Array2
java.lang.ArrayIndexOutOfBoundsException

at Array2.main(Array2.java:4)
Exception in thread "main"
C\>
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อาเรยหลายมิติ (Multidimensional Array)

0   1   2   3   4   5   6 

0 0 3 0 0 0 0a

0   1   2   3   4 

0 0 0 0 0

b

0 0 0 4 0

0 0 0 0 0

0   

1   

2       

int [] a = new int[7];
a[2] = 3;

int [] a = new int[7];
a[2] = 3;

int [][] b = new int[3][5];
b[1][3] = 4;

int [][] b = new int[3][5];
b[1][3] = 4;

หนึ่งมิติ
(vector)

สองมิติ
(matrix)
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Initializer List

0   1   2   3   4 

1 2 3 4 5

b

5 4 3 2 1

10 20 30 40 50

0   

1   

2       

int [][] b = { {1, 2, 3, 4, 5},
{5, 4, 3, 2, 1},
{10, 20, 30, 40, 50} }; 

int [][] b = { {1, 2, 3, 4, 5},
{5, 4, 3, 2, 1},
{10, 20, 30, 40, 50} }; 
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อาเรยหลายมิติคืออาเรยของอาเรย

int [][] b = new int[3][5];int [][] b = new int[3][5];

int [][] b;
b = new int[3][];
b[0] = new int[5];
b[1] = new int[5];
b[2] = new int[5];

int [][] b;
b = new int[3][];
b[0] = new int[5];
b[1] = new int[5];
b[2] = new int[5];

0   1   2   3   4 

0 0 0 0 0

0 0 0 0 0

0 0 0 0 0

0   

1   

2       

b
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Method : subprogram, function, procedure

• จาวาเรียกวา method

public class A {
public static void main(String[] args) {

int[] d = { 1, 2, 3, 4, 5, 6, 7 };
int s = find( d, 5 );
...

}
static int find( int[] data, int x ) {

int i;
for (i = data.length-1; i >= 0; i--) {
if (data[i] == x) break;

}
return i;

}
}

public class A {
public static void main(String[] args) {

int[] d = { 1, 2, 3, 4, 5, 6, 7 };
int s = find( d, 5 );
...

}
static int find( int[] data, int x ) {

int i;
for (i = data.length-1; i >= 0; i--) {
if (data[i] == x) break;

}
return i;

}
}
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Lab 1

• มีขอมูลกีคู่ที่มคีาแตกตางกันอยู k ใน array 1 มติิ ?
• เชน ให k = 1 และ array มขีอมลูเปน

10, 9, 12, 1, 8, 2
• จะไดวามีขอมูลอยู 3 คูมีทีค่าแตกตางกันอยู 1 ดังนี้

(10,9), (9,8), (1,2) ดังนั้น diffByK จะคืนคา 3

public class DiffByK {
...
static int diffByK (int[] array, int k) {

}
}

public class DiffByK {
...
static int diffByK (int[] array, int k) {

}
}

ทดสอบ : Run JUnit ของ lab1ทดสอบ : Run JUnit ของ lab1

ตองเพิม่ junit.jar ใน build pathตองเพิม่ junit.jar ใน build path
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Project -> Properties

<eclipse folder>\plugins\org.junit_3.8.1\junit.jar


